SOPHOS

simple +secure

Sophos Enterprise Console
guick startup guide

Product version: 5.0
Documen t date: February 2012

& e ™M © O O



Contents

10

11

12

13

14

15

16

17

18

19

20

ADOUL This GUIAE....c.eevrieieiiiiirieicettrt ettt ettt ettt b e seaes 3
What do TInstall?......ccoiiiiiiiii e 4
WHhat are the Ky SEPST....c.civiriiuiiiriririeieetirieteect ettt ettt ettt 5
SYSLEIM TEQUITEIMEIIS. ....euveueeueerereeeteieriete et ettt ettt et b e e et et be e et et se s e e et sesse e emeemesnen 6
The aCCOUNTS YOU NEEM.....viuiuiiiriiieiiiiriice ettt ettt ettt esaesne 8
Prepare fOr INStAllation.......ccceueirieirieieirieerie sttt ettt ettt b ettt et b et be e b 9
Download the INSTAllers........c.cccvririiuiiiriririecccere ettt eaes 10
Install ENterprise COMSOLE .......ccevueirirueririeririeerieerteiestrie et eee et ettt b et st e e et b et st e s e s e ebenessenes 11
Download SECUTILY SOTEWATE.....cccevrviueueiiiririeieiecrtete ettt ettt ettt ees 12
INStall NAC MANAGET ....coveveirieirienerieieerieerteiestetee st eesee et e et ste et ese e s be e st ese st es et be e saeseneebenestenensenenees 13
Create COMPULET GIOUPS...ccevririeiruirriiriiitiestet et ss ettt sre s et e s a et e s s b e b et s s be b e s e e st s b e s e s eneenes 14
St UP SECUTILY POLICIES...ueueviirreirieiteietrteerteert ettt ettt ettt b et b et sa b et se e s enenees 15
S€ArCh fOT COMPULETS.....cueeuiuieieirteiitetet ettt ettt ettt sttt ettt et b e st e e e e b e et e et enanees 16
Prepare tO Protect COMPULETS.....coiiiiriiriiriiiirinititirret sttt resr st ss b b s 17
Protect COMPULEIS....ciiiiiiiiiiiieiietertete ettt sttt st s st st e saaesaaesanesanesne 19
Check the health of yOUTr NEtWOTK....c.ccuruiiiriiiieiiececc et 21
TrOUDIESROOING. ...ttt ettt et 22
Get help With COMMON taASKS....ccueciriiirieiiririeirieete ettt ettt 23
TECRNICAL SUPPOTT..einitiiieiieeete ettt ettt ettt ettt b e ettt et et et e b e et e et ene 24
Le@al TOTICES..cueveuerreuiieieteietrte ettt ettt ettt ettt ettt et ettt b et et e bbb e et ene e 25



quick startup guide

1 About this guide

This guide tells you how to protect your network with Sophos security software.
If you are installing Sophos software for the first time, read this guide.

If you are upgrading, download and run the Sophos Enterprise Console installer. This will guide
you through the upgrade. See Download the installers (page 10)

Note: If you have a very large network, you may want to consider the installation options in the
Sophos Enterprise Console advanced startup guide.
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2 What do | install?

You install two management tools:

m Sophos Enterprise Console. This enables you to install and manage security software on your
computers.

m Sophos NAC Manager. This enables you to use “network access control”, which can prevent
access by unauthorized computers or computers that do not comply with your security
standards.

Installation of NAC Manager is optional.
Note: You install the tools separately, using two different setup programs.

Note: You can install both tools on the same server. However, if you have more than 1,000
computers, you should install the tools on different servers. The procedure is the same.
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What are the key steps?

You carry out these key steps:

Check the system requirements.
Create the accounts you need.
Prepare for installation.
Download the installers.
Install Enterprise Console.
Download security software.
Install NAC Manager.

Create computer groups.

Set up security policies.
Search for computers.
Prepare to protect computers.
Protect computers.

Check the health of your network.
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4 System requirements

4.1

4.2

Check the hardware, operating system and system software requirements before you begin
installation.

Hardware and operating system

For hardware and operating system requirements, see the system requirements page of the Sophos
website (http://www.sophos.com/products/all-sysreqs.html).

Microsoft system software

Enterprise Console requires certain Microsoft system software (for example, database software).

The Enterprise Console installer attempts to install this system software if it is not already available
on your server. However, in some cases, software is incompatible with your server or needs to be
installed manually.

SQL Server installation

The installer attempts to install SQL Server 2008 Express, unless you already have SQL Server 2005
Express or later. Note that:

m  We recommend that you do not install SQL Server on a domain controller.

m  SQL Server 2008 Express is not compatible with Windows Server 2003 SP1 or Windows Essential
Business Server 2008.

= On Windows Server 2008 R2 Datacenter, you must raise the domain functional level to Windows
Server 2003, as explained at http://support.microsoft.com/kb/322692

NET Framework installation
The installer attempts to install NET Framework 3.5 SP1, unless it is already installed. Note that:

m The installer cannot install . NET Framework 3.5 SP1 on a computer running Windows Server
2008 R2 or Windows Server 2008 SP1. You must add it from the Features section of Server
Manager.

Note: After you install the required system software, you may need to restart your computers.
For more information, see Sophos support knowledgebase article 65190
(http://www.sophos.com/support/knowledgebase/article/65190.html).

Microsoft Message Queuing installation

The installer attempts to install Microsoft Message Queuing (MSMQ), unless it is already installed.
Note that:

m During MSMQ installation, the following services are stopped: MSDTC, MSSQLServer,
SQLSERVERAGENT. This interrupts access to the default SQL Server database.


http://www.sophos.com/products/all-sysreqs.html
http://support.microsoft.com/kb/322692
http://www.sophos.com/support/knowledgebase/article/65190.html
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You should ensure that the services can safely be stopped during installation. You should also
check that they have restarted afterwards.
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5.1

5.2

The accounts you need

Before you install Sophos software, you should create the user accounts you need:

m Database account. This enables Enterprise Console's management service to connect to the
database. It is also used by other Sophos services.

m Update Manager account. This enables your endpoint computers to access the folders where
Enterprise Console puts software updates.

Database account

The database account should:

m Beable to log onto the computer where you are going to install the Sophos Management Server
(a component of Enterprise Console).

m Be able to read and write to the system temporary directory e.g. "\windows\temp\". By default
members of "Users" have this right.

m Have a UPN (User Principal Name) associated with the account if it is a domain account.

All other rights and group memberships that it needs are granted automatically during installation.
Sophos recommends that the account:

m Js not set to expire and does not have any other logon restriction.

m [s not an administrative account.

m [s not changed after installation.

For more information, see Sophos support knowledgebase article 113954
(http://www.sophos.com/support/knowledgebase/article/113954.html)

Update Manager account

The Update Manager account should have Read access to the folder where Enterprise Console
puts software updates. By default this is: \\[servername]\SophosUpdate

Sophos recommends that the account:

m [s not set to expire and does not have any other logon restriction.

m Js not an administrative account.

m Has a UPN (User Principal Name) associated with the account if it is a domain account.

For more information, see Sophos support knowledgebase article 113954
(http://www.sophos.com/support/knowledgebase/article/113954.html)


http://www.sophos.com/support/knowledgebase/article/113954.html
http://www.sophos.com/support/knowledgebase/article/113954.html
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6 Prepare for installation

Select a server that meets the system requirements and prepare as follows:
m Ensure that you are connected to the internet.

m Ensure that you have the Windows operating system CD and Service Pack CDs. You may be
prompted for them during installation.

m [f the server is running Windows Server 2008 or later, turn off User Account Control (UAC)
and restart the server.

Note: You can turn UAC on again after you have completed the installation and downloaded
your security software.
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7 Download the installers

Note: You can download the installers at any computer and then copy them to the computer
where you will use them.

1. Go to http://www.sophos.com/support/updates/.
2. Type your MySophos username and password.
3. On the web page for Enterprise downloads, you should:

m Download the Enterprise Console installer.
m If you want to use NAC Manager, download the Sophos NAC installer.

4. If you are not at the computer where you want to install the software, copy the installers to
that computer.

Alternatively, copy the installers to a CD or DVD and take them to the computer.

10
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8 Install Enterprise Console

To install Enterprise Console:

1.

At the computer where you want to install Enterprise Console, log on as an administrator:

m [f the server is in a domain, use a domain account that has local administrator rights.
m [f the server is in a workgroup, use a local account that has local administrator rights.

Find the Enterprise Console installer that you downloaded earlier.

Tip: The installer file name includes "sec".

3. Double-click the installer.

When you are prompted, click Install.

The installation files are copied to the computer and a wizard starts.

The wizard guides you through installation. You should do as follows:
a) Accept the defaults wherever possible.
b) On the Components Selection page, ensure that all the components are selected.

¢) On the Database details page, enter details of an account that can access the computer
where you are installing Enterprise Console. This should not be an administrator account.

When installation is complete, you may be prompted to restart. Click Yes or Finish.

11
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9 Download security software

When you log back on (or restart) for the first time after installation, Enterprise Console opens
automatically and a wizard runs.

Note: If you used Remote Desktop for installation, the console does not open automatically. Open
it from the Start menu.

The wizard guides you through selecting and downloading security software. You should do as
follows:

1. On the Sophos Download Account Details page, enter the username and password printed
on your license schedule. If you access the internet via a proxy server, select the Access Sophos
via a proxy server checkbox.

2. On the Platform selection page, select only the platforms you need to protect now.

When you click Next, Enterprise Console begins downloading your software.

3. On the Downloading Software page, downloading progress is displayed. Click Next at any
time.

4. On the Import computers from Active Directory page, select Set up groups for your computers
if you want Enterprise Console to use your existing Active Directory computer groups.

If you turned off User Account Control before installation, you can now turn it on again.

12
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10 Install NAC Manager

Ensure that you have the Windows operating system CD and Service Pack CDs. You may be
prompted for them during installation.

Note: If you install NAC Manager on a different server from Enterprise Console, you must install
a SQL Server 2005 or later database manually first.

1. At the computer where you want to install NAC Manager, log on as an administrator.

m [f the server is in a domain, use a domain account that has local administrator rights.
m [f the server is in a workgroup, use a local account that has local administrator rights.

2. Find the Sophos NAC installer that you downloaded earlier.
Tip: The installer file name includes "nac".

3. Double-click the installer.
4. In the Sophos NAC Manager dialog box, click Install.

5. A wizard guides you through installation.

13
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11 Create computer groups

If you used the Download Security Software Wizard to set up your computer groups (based on
your Active Directory groups), skip this section. Go to Set up security policies (page 15).

Before you can protect and manage computers, you need to create groups for them.

1. If Enterprise Console is not already open, open it.

2. In the Groups pane (on the left-hand side of the console), ensure that the server name shown
at the top is selected.

3. On the toolbar, click the Create group icon.

A "New Group" is added to the list, with its name highlighted.
4. Type a name for the group.

To create further groups, go to the left-hand pane. Select the server shown at the top if you want
another top-level group. Select a group if you want a sub-group within it. Then create and name
the group as before.

14
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12 Set up security policies

12.1

Enterprise Console applies “default” security policies to your computer groups. You do not have
to change these policies unless you want to, with these exceptions:

®m You must set up a firewall policy now.

m You must edit the network access control, application control, data control, device control, or
web control policies if you want to use these features. You can do this any time.

Set up a firewall policy

Note: During the installation of firewall, there will be a temporary disconnection of network
adapters. The interruption may cause the disconnection of networked applications, such as Remote
Desktop.

By default, the firewall blocks all non-essential connections. Therefore you must configure the
firewall before you protect your computers.

1. In the Policies pane, right-click Firewall, and click Create Policy.

A New Policy is added to the list, with its name highlighted. Type the name that you want to
use for the policy.

2. Double-click the policy to edit it.

A wizard is launched.

3. In the Firewall Policy Wizard we recommend that you make the following selections.

a) On the Configure firewall page, select Single location unless you want the firewall to use
different settings according to the location where you use it.

b) On the Operational Mode page, select Block inbound and allow outbound traffic.
¢) On the File and print sharing page, select Allow file and print sharing.

15
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13 Search for computers

You must search for computers on the network before Enterprise Console can protect and manage
them.

1. Click the Discover computers icon in the toolbar.
2. Select the method you want to use to search for computers.

3. Enter account details if necessary and specify where you want to search.

If you use one of the Discover options, the computers are placed in the Unassigned group.

16



quick startup guide

14

14.1

14.2

14.3

Prepare to protect computers

Before you protect computers, you must prepare them as follows:

m Prepare for removal of third-party security software.

m Check that you have an account that can be used to install software.
m Prepare for installation of anti-virus software.

m Prepare for installation of network access control.

Prepare for removal of third-party security software
If you want the Sophos installer to remove any previously installed security software, do the
following:

m [f computers are running another vendor's anti-virus software, ensure that its user interface is
closed.

m [f computers are running another vendor's firewall or HIPS product, ensure that it is turned
off or configured to allow the Sophos installer to run.

If computers are running another vendor's update tool, you may want to remove it. See "Remove
third-party security software" in the "Protecting computers" section of the Enterprise Console
Help.

Check that you have an account that can be used to install software
You will be prompted to enter details of an account that can be used to install security software.
This is typically a domain administrator account. It must:

m Have local administrator rights on computers you want to protect.

m Be able to log on to the computer where you installed Enterprise Console.

m Have read access to the location that computers will update from. To check this location, in
the Policies pane, double-click Updating, and then double-click Default.

Prepare for installation of anti-virus software

You must prepare computers for installation of anti-virus software.

If you use Active Directory, you can prepare your computers using a Group Policy Object (GPO).
For instructions, see Sophos support knowledgebase article 111180
(http://www.sophos.com/support/knowledgebase/article/111180.html).

If you use workgroups, you must configure computers locally. For instructions, see Sophos support
knowledgebase article 29728 (http://www.sophos.com/support/knowledgebase/article/29728.html).

17


http://www.sophos.com/support/knowledgebase/article/111180.html
http://www.sophos.com/support/knowledgebase/article/29728.html

Sophos Enterprise Console

14.4 Prepare for installation of network access control

Before you can install network access control on computers, you must:

m Specify the URL of the computer where you installed NAC Manager. In Enterprise Console,
select Tools > Configure NAC URL.

18
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15 Protect computers

15.1

15.2

This section tells you how to:
m Protect Windows computers automatically.

m Protect Windows computers or Macs manually.

Protect Windows computers automatically

To protect computers, do as follows:

1. Select the computers you want to protect.

2. Right-click and select Protect computers.

Note: If computers are in the Unassigned group, simply drag them to your chosen groups.

3. A wizard guides you through the installation of Sophos security software. You should do as
follows:

a) On the Select features page, you can install optional features. Select Compliance Control
if you want network access control.

b) On the Protection summary page, check for any installation problems. For help, see
Troubleshooting (page 22).

¢) On the Credentials page, enter details of an account that can be used to install software on
computers.

Installation is staggered, so that the process may not be complete on all the computers for some
time.

When installation is complete, look at the list of computers again. In the On-access column, the
word Active indicates that the computer is running on-access virus scanning.

Protect Windows computers or Macs manually

If you have computers that you cannot protect automatically, you protect them by running an
installer from the shared folder to which the security software has been downloaded. This folder
is known as the bootstrap location.

You must use an administrator account on the computers that you want to protect.

To protect Windows computers or Macs manually:

1. In Enterprise Console, on the View menu, click Bootstrap Locations.

A list of locations is displayed. Make a note of the location for each operating system you want
to protect.

19
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2. At each computer that you want to protect, locate the installer in the bootstrap location and
double-click it.

m For Windows computers, the installer is called setup.exe.
m  For Macs, the installer is called Sophos Anti-Virus.mpkg.

A wizard guides you through installation. Accept the default options, except as shown below:

m  On the User account details page, enter details of the account that you specified for access
to Update Manager. You did this when you installed Enterprise Console.

Tip: If you're not sure which account this is, use any low-privilege account that can access
the bootstrap location. Enterprise Console will apply an updating policy that includes the
right user account details later.
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16 Check the health of your network

To check the health of your network from Enterprise Console, do as follows.

1. On the menu bar, click the Dashboard icon (if the Dashboard is not already displayed).
The Dashboard shows you how many computers:
m Have detected threats.
m  Are out of date.

= Do not comply with policies.

2. If you are using NAC, you can also:
a) Select File > Open > NAC.
b) In NAC Manager, select Report > Compliance .

This shows you whether computers comply with NAC policy.

21
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17 Troubleshooting

When you run the Protect computers wizard, installation of security software can fail for a number
of reasons:

m  Automatic installation is not possible on that operating system. Perform a manual installation.
See Protect Windows computers or Macs manually (page 19) . For other operating systems, see
the Sophos Enterprise Console startup guide for Linux, NetWare and UNIX.

m Operating system could not be determined. This may be because you did not enter your
username in the format domain\username when finding computers.

m The computers are running a firewall.

22
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18 Get help with common tasks

This section tells you where you can find information on how to carry out common tasks.

SEC = Sophos Enterprise Console

Task Document

Protect Linux computers SEC 5.0 startup guide for Linux, NetWare and UNIX:
"Protecting Linux computers"

Protect standalone computers SEC 5.0 advanced startup guide:
"Protecting standalone computers"

Configure Enterprise Console policies Enterprise Console Help:
"Configuring policies”
Configure NAC NAC Manager Help:

"Manage overview"

Give network access to guest users Sophos Compliance Agent configuration guide:
"Dissolvable agent"

Deal with alerts Enterprise Console Help:
"Dealing with alerts and errors"

Clean up computers Enterprise Console Help:
"Cleaning up computers"

Generate SEC reports Enterprise Console Help:
"Generating reports”

Generate NAC reports NAC Manager Help:
"Report overview"

23
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19 Technical support

You can find technical support for Sophos products in any of these ways:

Visit the SophosTalk community at http://community.sophos.com/ and search for other users
who are experiencing the same problem.

Visit the Sophos support knowledgebase at http://www.sophos.com/support/.
Download the product documentation at http://www.sophos.com/support/docs/.

Send an email to support@sophos.com, including your Sophos software version number(s),
operating system(s) and patch level(s), and the text of any error messages.


http://community.sophos.com/
http://www.sophos.com/support/
http://www.sophos.com/support/docs/
mailto:support@sophos.com
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20 Legal notices

Copyright © 2009-2012 Sophos Limited. All rights reserved. No part of this publication may be
reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic,
mechanical, photocopying, recording or otherwise unless you are either a valid licensee where the
documentation can be reproduced in accordance with the licence terms or you otherwise have
the prior permission in writing of the copyright owner.

Sophos and Sophos Anti-Virus are registered trademarks of Sophos Limited. All other product
and company names mentioned are trademarks or registered trademarks of their respective owners.

ACE™, TAO™, CIAO™, and CoSMIC™

ACE!, TAO?, CIAO?, and CoSMIC* (henceforth referred to as “DOC software”) are copyrighted
by Douglas C. Schmidt’ and his research group® at Washington University’, University of
California®, Irvine, and Vanderbilt University’, Copyright © 1993-2005, all rights reserved.

Since DOC software is open-source, free software, you are free to use, modify, copy, and
distribute—perpetually and irrevocably—the DOC software source code and object code produced
from the source, as well as copy and distribute modified versions of this software. You must,
however, include this copyright statement along with code built using DOC software.

You can use DOC software in commercial and/or binary software releases and are under no
obligation to redistribute any of your source code that is built using DOC software. Note, however,
that you may not do anything to the DOC software code, such as copyrighting it yourself or
claiming authorship of the DOC software code, that will prevent DOC software from being
distributed freely using an open-source development model. You needn’t inform anyone that
you're using DOC software in your software, though we encourage you to let us'® know so we can

promote your project in the DOC software success stories' .

DOC software is provided as is with no warranties of any kind, including the warranties of design,
merchantability, and fitness for a particular purpose, noninfringement, or arising from a course
of dealing, usage or trade practice. Moreover, DOC software is provided with no support and
without any obligation on the part of Washington University, UC Irvine, Vanderbilt University,
their employees, or students to assist in its use, correction, modification, or enhancement. A
number of companies'? around the world provide commercial support for DOC software, however.
DOC software is Y2K-compliant, as long as the underlying OS platform is Y2K-compliant.

Washington University, UC Irvine, Vanderbilt University, their employees, and students shall
have no liability with respect to the infringement of copyrights, trade secrets or any patents by
DOC software or any part thereof. Moreover, in no event will Washington University, UC Irvine,
or Vanderbilt University, their employees, or students be liable for any lost revenue or profits or
other special, indirect and consequential damages.

The ACE", TAO™, CIAO"?, and CoSMIC!® web sites are maintained by the DOC Group17 at the
)!® and the Center for Distributed Object Computing
of Washington University, St. Louis'® for the development of open-source software as part of the
open-source software community”’. By submitting comments, suggestions, code, code snippets,

Institute for Software Integrated Systems (ISIS
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techniques (including that of usage), and algorithms, submitters acknowledge that they have the
right to do so, that any such submissions are given freely and unreservedly, and that they waive
any claims to copyright or ownership. In addition, submitters acknowledgethat any such submission
might become part of the copyright maintained on the overall body of code, which comprises the
DOC software. By making a submission, submitter agree to these terms. Furthermore, submitters
acknowledge that the incorporation or modification of such submissions is entirely at the discretion
of the moderators of the open-source DOC software projects or their designees.

The names ACE, TAO, CIAO, CoSMIC, WashingtonUniversity, UC Irvine, and Vanderbilt
University, may not be used to endorse or promote products or services derived from this source
without express written permission from Washington University, UC Irvine, or Vanderbilt
University. Further, products or services derived from this source may not be called ACE, TAO,
CIAQO, or CoSMIC nor may the name Washington University, UC Irvine, or Vanderbilt University
appear in their names, without express written permission from Washington University, UC
Irvine, and Vanderbilt University.

If you have any suggestions, additions, comments, or questions, please let me?! know.

Douglas C. Schmidt**
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Apache

The Sophos software that is described in this document may include some software programs that
are licensed (or sublicensed) to the user under the Apache License. A copy of the license agreement
for any such included software can be found at http://www.apache.org/licenses/LICENSE-2.0.

Boost
Version 1.0, 17 August 2003

Permission is hereby granted, free of charge, to any person or organization obtaining a copy of
the software and accompanying documentation covered by this license (the “Software”) to use,
reproduce, display, distribute, execute, and transmit the Software, and to prepare derivative works
of the Software, and to permit third-parties to whom the Software is furnished to do so, all subject
to the following:

The copyright notices in the Software and this entire statement, including the above license grant,
this restriction and the following disclaimer, must be included in all copies of the Software, in

whole or in part, and all derivative works of the Software, unless such copies or derivative works
are solely in the form of machine-executable object code generated by a source language processor.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND
NON-INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR ANYONE
DISTRIBUTING THE SOFTWARE BE LIABLE FOR ANY DAMAGES OR OTHER LIABILITY,
WHETHER IN CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

Common Public License

The Sophos software that is referenced in this document includes or may include some software
programs that are licensed (or sublicensed) to the user under the Common Public License (CPL),
which, among other rights, permits the user to have access to the source code. The CPL requires
for any software licensed under the terms of the CPL, which is distributed in object code form,
that the source code for such software also be made available to the users of the object code form.
For any such software covered under the CPL, the source code is available via mail order by
submitting a request to Sophos; via email to support@sophos.com or via the web at
http://www.sophos.com/support/queries/enterprise.html. A copy of the license agreement for any
such included software can be found at http://opensource.org/licenses/cpl1.0.php

ConvertUTF
Copyright 2001-2004 Unicode, Inc.

This source code is provided as is by Unicode, Inc. No claims are made as to fitness for any
particular purpose. No warranties of any kind are expressed or implied. The recipient agrees to
determine applicability of information provided. If this file has been purchased on magnetic or
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optical media from Unicode, Inc., the sole remedy for any claim will be exchange of defective
media within 90 days of receipt.

Unicode, Inc. hereby grants the right to freely use the information supplied in this file in the
creation of products supporting the Unicode Standard, and to make copies of this file in any form
for internal or external distribution as long as this notice remains attached.

Loki
The MIT License (MIT)
Copyright © 2001 by Andrei Alexandrescu

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction,
including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do
s0, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

OpenSSL cryptographic toolkit

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License
and the original SSLeay license apply to the toolkit. See below for the actual license texts. Actually
both licenses are BSD-style Open Source licenses. In case of any license issues related to OpenSSL
please contact openssl-core@openssl.org.

OpenSSL license
Copyright © 1998-2011 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgment:
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“This product includes software developed by the OpenSSL Project for use in the OpenSSL
Toolkit. (http://www.openssl.org/)”

4. The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to endorse or promote
products derived from this software without prior written permission. For written permission,
please contact openssl-core@openssl.org.

5. Products derived from this software may not be called “OpenSSL” nor may “OpenSSL” appear
in their names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:

“This product includes software developed by the OpenSSL Project for use in the OpenSSL
Toolkit (http://www.openssl.org/)”

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” AND ANY EXPRESSED
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This
product includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay license
Copyright © 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The
implementation was written so as to conform with Netscape’s SSL.

This library is free for commercial and non-commercial use as long as the following conditions
are adhered to. The following conditions apply to all code found in this distribution, be it the RC4,
RSA, lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this
distribution is covered by the same copyright terms except that the holder is Tim Hudson
(tth@cryptsoft.com).

Copyright remains Eric Young’s, and as such any Copyright notices in the code are not to be
removed. If this package is used in a product, Eric Young should be given attribution as the author
of the parts of the library used. This can be in the form of a textual message at program startup
or in documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the
following disclaimer.
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2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement:

“This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)”

The word “cryptographic” can be left out if the routines from the library being used are not
cryptographic related :-).

4. If you include any Windows specific code (or a derivative thereof) from the apps directory
(application code) you must include an acknowledgement:

“This product includes software written by Tim Hudson (tjh@cryptsoft.com)”

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS” AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

The license and distribution terms for any publically available version or derivative of this code
cannot be changed. i.e. this code cannot simply be copied and put under another distribution
license [including the GNU Public License.]
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